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Using DC5 or Live5 Forensics to Measure Sound Card 
Performance without External Test Equipment 

 
Diamond Cuts DC5 and Live5 Forensics offers a broad suite of real time audio tools 
including noise reduction, audio enhancement, audio measurement and signal generation.  
This application note describes the use of these programs to measure the “Round-Trip” 
performance of a sound card without the need for any external test equipment.  Although 
this is not the most precise way to measure the performance of a sound card, it still 
provides a good figure of merit so that you can compare the performance of one card 
compared to another.   
 
This document assumes that the DC5 or Live5 Forensics software is installed and 
working in your system.  For help with installation or to get started with the software, 
refer to the users guide. 
 
Basic Requirments: 
DC5 or Live5 Forensics Software 
Win 98SE, Win ME, Win 2000 or Win XP 
200 MHz or faster PC with Pentium or AMD processor 
 
Other Requirements: 

    Full Duplex Sound Card as the Device Under Test 
Cables or Adapters to connect the two outputs (Left and Right) to the two 
inputs on the sound card. 
 

Sound Card Measurements possible with this technique: 
 Noise Floor:  A/D by itself (D/A – Inferred from Round Trip measurement)   
 Frequency Response: (Round-Trip only) 
 Total Harmonic Distortion: (Round-Trip only) 
 Anti-Aliasing Brick Wall Filter Performance 
 
Basic Theory: 
 Since two instances of Diamond Cut DC5 or Live5 Forensics can be run 
simultaneously on a computer, one instance can be used as a stimulus and the other as a 
measurement response to the behavior of a Device under Test, in this case a Full Duplex 
sound card.  No external test equipment is required for the abovementioned 
measurements using this method other than the appropriate cables required to connect the 
sound card outputs to its inputs.   This technique makes most of its measurements in a 
“round-trip” manner, meaning that both the D/A and A/D are measured simultaneously 



and cumulatively and the differences in performance between the two converters can not 
always be distinguished from one another.  This method cannot discriminate between the 
Total Harmonic Distortion of the D/A from the A/D.   However, the Noise Floor of the 
A/D alone can be measured using this method.  Lastly, you can evaluate the Anti-
Aliasing Brick wall filter performance of the D/A’s and A/D’s.  Since no sound card 
produces 0 % THD, then a signal within the frequency response of a sound card can 
produce products well above its sample rate / 2 value.  The degree of attenuation of these 
high frequency products is determined by the performance of the sound card anti aliasing 
filters.  Their job is to prevent signal distortion products from producing wrap around 
aliasing signals from being heard. This aspect of sound card performance can be 
evaluated implementing steps 7 and 8.   
 
Process Overview: 

The overall measurement process can be broken down into a few basic steps.  One 
or all of these tests may be performed.  They are as follows: 
 

1. Making the Connections (Connecting the Analog signals together on the sound 
Card) 

2. Calibrating the Recording Gain of the input side of the Sound Card 
3. Measuring the Noise Floor of the Round-Trip (D/A & A/D) 
4. Measuring the Noise Floor of the A/D by itself 
5. Measuring the Frequency Response of the Round-Trip 
6. Measuring the %THD Round-Trip 
7. Evaluating Heterodyning products 
8. Evaluating D/A and A/D Anti-Aliasing Filters Performance  

 
   
These procedures assume that the software and sound card drivers are up and running on 
your computer.   
 
1. Making the Connections: Connect the Left Input on your sound card to the Left 
Output and the Right Input to the Right Output.  Some sound cards use 1/8 inch stereo 
mini phone jacks.  Usually, these are connected to your audio equipment via cables with 
1/8 inch stereo mini phone jacks on one end and RCA male plugs on the other.  You local 
electronics store will have inexpensive RCA male-to-male converters so that you can 
interconnect the soundcard outputs and inputs.  If you are testing a higher end sound card, 
you may be dealing with ¼ inch TRS (Tip Ring Sleeve) type jacks.  In that case, you will 
need to purchase 4 cables to connect the respective inputs to the respective outputs of the 
card.  To realize the full performance of TRS, it is important to maintain the integrity of 
the fully differential capability of TRS.  Do not convert a TRS system it to a single ended 
system for the measurement process as it will compromise it, especially if you expect to 
observe something close to the advertised performance level of the card under test 
 
2. Calibrating the Recording Gain:  Launch the Diamond Cut software program.  We 
shall refer to this as Instance One for the remainder of the discussion.  Instance One will 
be our Test Stimulus.  Perform the following procedure: 



1. Go to the Edit/Preferences/Soundcard menu, and set up the output device to be the 
i. Soundcard under test. 

2. Bring up the Make Waves Generator found under the Edit menu 
3. Set the Generator to the following parameters: 

i. Frequency: 1 KHz 
ii. Amplitude: 0 dB Peak 

iii. Length: 60 Seconds 
iv. File Type: Stereo 
v. Sampling Rate: Desired Value or no less than 44.1 KHz 

vi. Waveshape: Sine 
vii. Resolution: Desired Value or no less than 16 bits 

4. Click OK on the Make Waves Generator 
5. The 1 KHz Waveform will be displayed after a moment or two in the Source  

Display 
6. Click on “Looped Play” 
7. Minimize Instance One of the Diamond Cut program. 
8. Launch another Instance of the Diamond Cut program. 
9. Go to the Edit/Preferences/Soundcard menu, and set up the input device to be the 

Soundcard under test. 
10. Click on the Record Button, and put the recorder in Record – Pause.   
11. Bring up the control panel for your sound card, and go to the Recording options 

and adjust the Line input until the VU meters on the Diamond Cut recorder are 
just touching on 0 dB.  Also, while you are in this panel, be sure that all other 
inputs are turned off. 

12. You are now done calibrating the system and ready for the testing phase. 
 
 

3. Measuring the Noise Floor of the Round-Trip (D/A & A/D): 
 1. Un-minimize the First Instance of Diamond Cut.  
 2. Stop the Looped Play function 
 3. Go to the Makes Waves Signal Generator, and set it up as follows: 

i. Frequency:  0.01 Hz 
ii. Amplitude: -97dB Peak 

iii. Length: 600 Seconds 
iv. File Type: Stereo 
v. Sampling Rate: Desired Value or no less than 44.1 KHz 

vi. Waveshape: Sine 
vii. Resolution: Desired Value or no less than 16 bits 

 
4. Click OK on the Make Waves Generator 
5. A “null set” waveform should present itself after a few moments of 
    calculations 
6. Highlight the Entire Wavefile 
7. Find the Mute button under the Edit menu, and apply it to the Wavefile 
8. Click on the play looped button, and you should see the cursor begin to move. 
9. Minimize the First Instance of Diamond Cut. 



10. Bring up the Second Instance of Diamond Cut 
11. Put it in Record mode and record for 60 Seconds. 
12. Save the resultant file as Noisefloor.wav 
13. Open the Noisefloor.wav file in the Second Instance of Diamond Cut. 
14. In the View Menu, bring up the Spectrum Analyzer. 
15. Set the Spectrum Analyzer Paramaters as follows: 
 FFT Size: 4096 
 Freq Resolution: 10.77 Hz 
 Range: 100 dB 
 Bar Mode 
 Window Type: Kaiser Bessel 
 Display Mode: Slow 
16. Click on Play Looped. 
17. Let the waveform build on the Spectrum Analyzer for about 30 Seconds. 
18. Click “Hold” on the Analyzer. 
19. The results that you see is the noise floor of the Round-Trip journey of your 

 sound card, except for the artifact on the left hand side of the screen.  This  
spike is an artifact of the FFT and is meaningless. 

              20. You can take a picture of the Round – Trip noise floor performance by  
using the Print Screen function. 
 

4. Measuring the Noise Floor of the A/D by itself (optional step) 
 1. Stop the playback on the Second Instance of Diamond Cut. 
 2. Disconnect the Left and Right Input Jacks from the Sound Card Output 
 3. Terminate each Input with a 100 Ohm Resistor 
 4. Put the Second Instance into Record Mode and record for 60 seconds. 
 5. Save the resultant file as Analogtodigitalconverter.wav 
 6. Open this file in the Source window of the Second Instance of Diamond Cut. 

      7. With the Spectrum Analyzer set to the same settings as before, and the lower 
             right hand button clicked to the Run rather than the Hold position.  

 8. Click on “Looped Play.” 
 9. The results that you now see is the noise floor of the A/D converter of your 
                    sound card by itself.  
 10. You can take a picture of this waveform using the Print Screen Function. 
 11. The D/A Converter performance is approximately the difference between the 
                  two graphs that you have printed. 

      12. Disconnect the Input terminating Resistors. 
      13. Connect the the two sound card inputs back into the sound card outputs. 

 
5. Measuring the Frequency Response of the Round-Trip 
 1. Minimize the Second Instance of Diamond Cut and Maximize the First. 
 2. Stop the Looped Play function. 
 3. Go to Make Waves 
 4. Set up the Generator in the Following manner: 

viii. Frequency: Not Applicable 
ix. Amplitude: -10 dB Peak 



x. Length: 600 Seconds 
xi. File Type: Stereo 

xii. Sampling Rate: Desired Value or no less than 44.1 KHz 
xiii. Waveshape: Random 
xiv. Resolution: Desired Value or no less than 16 bits 

 
5. Click OK and the resultant random noise file will ultimately present itself in the 
Source window. 
6. Click on looped Play 
7. Minimize the first instance of Diamond Cut and Maximize the Second Instance. 
8. Click on the Record function and record 60 Seconds on the noise file being 
played by the Generator in Instance One. 
9. Save this wavefile under the name of Testwhitenoise.wav 
10. Bring this wavefile into the Source window. 
11. Bring up the Spectrum Analyzer. 

 12. Set it up with the following parameters: 
 FFT Size: 4096 
 Freq Resolution: 10.77 Hz 
 Range: 20 dB 
 Bar Mode 
 Window Type: Kaiser Bessel 
 Display Mode: Averaging 
13. Play the wavefile 
14. Let it average for about 45 Seconds and then put it on Hold. 
15. The resulting graph is the Round – Trip Frequency Response of your Sound 

Card 
 

6. Measuring the %THD Round-Trip 
 1. Stop the Play function on the second instance of Diamond Cut. 
 2. Maximize the First instance of Diamond Cut, and bring up the Make 
  Waves Generator 
 3. Set the Generator for the Following Paramaters: 

xv. Frequency: 1 KHz 
xvi. Amplitude: -1 dB Peak 

xvii. Length: 60 Seconds 
xviii. File Type: Stereo 

xix. Sampling Rate: Desired Value or no less than 44.1 KHz 
xx. Waveshape: Sine 

xxi. Resolution: Desired Value or no less than 16 bits 
4. Click on OK, and the waveform should appear in the Source Window. 
5. Click on Looped Play 

            6. Minimize the First Instance and Maximize the Second Instance of Diamond 
                Cut 
            7. Bring Up the Recorder function and be sure that it is not overloading.  If it is, 
               go to the sound card control panel and bring down the gain just a tad until there 
               is not more clipping. 



8. Record this waveform and then name it Distortion.wav 
9. Bring Distortion.wav up in the Source window. 
10. Bring up the Spectrum Analyzer and set it up in the following manner: 
  FFT Size: 4096 
  Freq Resolution: 10.77 Hz 
  Range: 100 dB 
  Bar Mode 
  Window Type: Kaiser Bessel 
  Display Mode: Fast 

Show Peak: Check (order dependent) 
Show THD: Check (order dependent) 

  
 11. Click on Play Looped. 
 12. You will see the “THD = _______%” displayed 
 13. You must give the system a few seconds to stabilize on the final value.  
 14. Write down the steady state number.  Call it THDm 
 15. Perform the following calculation: 
 
 Sound Card %THD = ((THDm)^2 – (THDg)^2))^1/2  
 
 THDg = 0.84 % for 8 bits 
 THDg = 0.0033 % for 16 bits 
 THDg = 0.0008 % for 20 bits 
 THDg = 0.00025 % for 24 bits 

 
 

7. Evaluating Heterodyning Products 
1. Maximize Instance 1 of the Diamond Cut software. 
2. Go to the Make Waves Generator 
3. Set it up as Follows: 

i. Check the “Linear Sweep” Checkbox 
ii. Set the Frequency for 20 Hz 

iii. Set the Stop Frequency for 20,000 Hz 
iv. Set the Amplitude for 60 Seconds 

xxii. Waveshape: Sine 
v. Resolution: Desired Value or no less than 16 bits 

4. Click on OK. 
5. Listen to the resultant wavefile by clicking on the play button.  You should 

hear a very clear sweep in frequency from 20 Hz to 20 KHz.  If you hear 
another sweep going on of less loudness and lagging behind the first 
sweep, your sound card is producing heterodyning products.  Good sound 
cards should not do this, as it is a form of inter-modulation distortion. 

6. Stop the play at the end of the entire sweep and bring up the Spectrum 
Analyzer.  Set it as Follows: 

FFT Size: 4096 
  Freq Resolution: 10.77 Hz 



  Range: 100 dB 
  Bar Mode 
  Window Type: Kaiser Bessel 
  Display Mode: Fast 

Show Peak: Check  
Show THD: Uncheck 

7. Click play again, and note that the source signal consists of one spike 
which moves from the right hand side of the graph to the left.  Note that 
there are almost no spurious signals down near the noise floor.  This is the 
spectral content of the reference signal exciting your sound card.   

 
9. Stop the Playback and then put Instance One of Diamond Cut in play looped. 
10. Bring up the second instance of Diamond Cut and put it in Record mode 
11. Record two minutes worth of the file being played. 
12. Save it as Sweptsine.wav 
13. Bring Sweptsine.wav into the Source window 
14. Bring up the Spectrum Analyzer and set it up in the following manner: 

FFT Size: 4096 
  Freq Resolution: 10.77 Hz 
  Range: 100 dB 
  Bar Mode 
  Window Type: Kaiser Bessel 
  Display Mode: Fast 

Show Peak: Check  
Show THD: Uncheck 

15. Play the Sweptsine.wav wavefile while watching the Spectrum Analyzer 
16. A very high quality sound card will display a signal similar in noise floor as it 

sweeps as you observed in step 7.  A low quality sound card will have lots of 
extra heterodyning spikes dancing around above the noise floor as the signal 
sweeps. 

 
8. Evaluating Anti-Aliasing Filters Performance 

1. Bring up the First Instance of Diamond Cut. 
2. Set the Make Waves Generator as Follows: 

xxiii. Frequency:  22000 Hz 
xxiv. Amplitude: -3dB Peak 
xxv. Length: 60 Seconds 

xxvi. File Type: Stereo 
xxvii. Sampling Rate: Desired Value or no less than 44.1 KHz 

xxviii. Waveshape: Sine 
xxix. Resolution: Desired Value or no less than 16 bits 

 
3. Click OK and then put the wavefile in Play  Looped mode 
4. No sound should be heard from your loudspeakers (unless you are a dog!)  

Low quality sound cards will produce spurious sounds under this 
condition in the audible range.  High quality cards will not.  If you hear 



spurious signals present, this indicates a deficiency in the Anti-Aliasing 
brick wall filters in the D/A portion of your sound card. 

5. Minimize this First Instance of Diamond Cut. 
6. Bring up the Second Instance and Record the signal for about 60 Seconds 

at a level of – 3 dB. 
7. Save the Wavefile under the name 22KHzSine.wav. 
8. Open 22KHzSine.wav in the Source Window  
9. Open up the Spectrum Analyzer and set it as follows: 

FFT Size: 4096 
  Freq Resolution: 10.77 Hz 
  Range: 100 dB 
  Bar Mode 
  Window Type: Kaiser Bessel 
  Display Mode: Fast 

Show Peak: Check  
Show THD: Uncheck 

10. Play the 22KHzSine.wav wavefile 
11. Still, nothing should be heard from your loudspeakers.  If you do hear any 

spurious signals, you will also see them appear on the Spectrum Analyzer.  
This shows a deficiency in the %THD performance of your sound card  
coupled with its Anti-Aliasing brick wall filters.   
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